March, 2023

SmartAlign
for DigitalMicrograph

Image Registration and Scan-distortion

Compensation Plug-in

SmartAlign Manual 3.0
with Spectrum Image Acquisition

and

Template Matching Module
4D-STEM Module

HREM Research Inc.



SmartAlign Plug-in User Manual

Preface

This user manual describes how to install and operate the SmartAlign for STEM image/spectrum-
image/4D-STEM registration and scan-distortion compensation plug-in (version 3.0) for
DigitalMicrograph. The software described builds on the work from three manuscripts relating to:

1) image series registration and averaging:

Jones, L., et al.: “Smart Aligh—a new tool for robust non-rigid registration of scanning
microscope data”. Advanced Structural and Chemical Imaging, 1 8 (2015). Link

2) multi-frame spectrum-image registration and summation:

Jones, L et al.: “Managing dose-, damage- and data-rates in multi-frame spectrum-imaging”.
Microscopy, 67 (2018). Link.

3) multi-frame 4D-STEM dataset registration and summing:

O’Leary et al.: “Increasing Spatial Fidelity and SNR of 4D-STEM Using Multi-Frame Data
Fusion”. Microscopy & Microanalysis. 28 (4), (2022). Link.

As this tool applies post-processing steps to experimental data, users should state explicitly when
such steps have been applied by citing the above paper(s) such as:

“data alignment and scan-distortion compensation was performed using the SmartAlign
software described in [xx]”.

Most of this manual describes the processing of atomic resolution image series acquired in the
scanning transmission electron microscope (STEM), however the same steps apply to data from
the scanning tunnelling microscope (STM) and the atomic force microscope (AFM). A separate
section at the end of this manual describes settings specific to these physical probe techniques.

Contact

Enquiries regarding sales, licensing, installation and operation of the plug-in should be directed
to:
support@hremresearch.com

For questions about the academic manuscripts referenced above, please contact Dr Lewys Jones
at:
lewys.jones@tcd.ie

Copyright Statements

© Copyright 2015-2023 HREM Research Inc.

All rights reserved. This manual is protected by international copyright laws and treaties.
Unauthorized reproduction and distribution of this manual, or any portion of it, will be prosecuted

to the maximum extent possible and may result in severe civil and criminal penalties.

DigitalMicrograph is a trademark of Gatan Inc.
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When to use this Plug-in

The SmartAlign plug-in for Digital Micrograph is designed to correct the most common image
distortions encountered in atomic-resolution image series (or multi-frame spectrum-image series)
recorded in the scanning transmission electron microscope (STEM), including image drift between

frames and scan-distortion within each frame. These are shown schematically below:

Image Drift Scan-noise
[1-4] [5] [2,9]
Distortion | ’,',j j >
Frequency | ! ! ! ! ! J Hz
0 0.1 1 10 100 1,000 10,000
Correction Affine Super-local
Methodology Transform Transform
Image 50Hz (pixel-wise)
Translation Line-sync

Image distortion frequency domains. For a description of the references above, please see the
associated academic manuscript [1].

SmartAlign is used to correct image-drift and scan-distortion. Scan-noise however, caused by

instabilities up in the kHz regime, can be corrected using the Jitterbug plug-in also available from

HREM Research [2].

For spectrum-images and 4D-STEM, where pixel times may be 100 to 10,000 times slower than
basic STEM imaging, the frequency ranges that may disturb experimental data are moved lower

commensurately.

Artefact Type
(and correction methodology required)
Image Drift Scan-noise
(Translation «—— Affine Transform) (Local Pixel-wise Shifis)

2D Images Intra-line / Pixel-wise

3D Spectra
4D-STEM

[, Distortion Frequency
I T T T T T | I— T T >
0 00001 0001 001 0.1 1 10 100 1,000 10000 Hz

* 50/60 Hz Line-sync
Examples of possible frequency ranges of image/data distortions depending on typical pixel times
used in each experiment type [3].

Image offsets between frames in a series are readily identifiable. These can be easily corrected to

simply the analysis of time-series or focal-series data. Scan-distortion can appear as additional
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image transformations, including affine transformations (stretch, skew / shear, small rotations)

and non-linear distortions, causing otherwise straight crystal lattice planes to become ‘wavy’.

If your data includes these types of shifts and/or distortions, then it may be possible to recover
some or all of the lost performance caused by scan-distortion. Of course if the image is very heavily
degraded it will not be possible to compensate this entirely. Equally this plug-in cannot create
resolution that did not exist prior to the incorporation of scan-noise. For further information and

some related reading please see the reference given on page 2.

ol
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Installation

Software Requirements

The following is a list of the software requirements necessary to run the SmartAlign plug-in:

. DigitalMicrograph (GATAN™ ) with DigiScan and EMControl

° USB Key Driver

° HREM Mouse Tool Plug-in (Free-ware downloadable from www.hremresearch.com)
° IPU Plug-in (Free-ware downloadable from www.hremresearch.com)

° Acquire Image Series (Free-ware downloadable from www.hremresearch.com)

If you don’t have Gatan S| Picker Tool, the HREM Picker Tool is necessary to run the 4D-STEM
module:

. HREM Picker Tool Plug-in (Free-ware downloadable from www.hremresearch.com)

For the spectrum-image acquisition options, this also requires:

e DigitalMicrograph (GATAN™ ) Spectrum Image (SI) base module, EELS module, EDS module.

Software Installation
Installing USB Key Driver
The user key driver should be installed by following the instructions given by the key driver

installer. The key driver installer can be found on our web site.

Installing SmartAlign Plug-in
The plug-in can be installed by drag-and-drop copy to the folder “Plugins” (The Pluglns folder

should exist under a normal installation of the DigitalMicrograph.)

When the DigitalMicrograph is launched after placing the plug-ins into the Plugins folder,

SmartAlign menu commands will appear under “SmartAlign” menu.

Installing HREM Mouse Tools, IPU and Acquire Image Series Plug-ins
All the files relating these tool plug-ins, can be installed by drag-and-drop copy to the folder

“Pluglins.”

Installing Template Matching Module and/or 4D-STEM Module
These modules can be installed by drag-and-drop copy to the folder “Plugins”. Please note that

these modules require additional licenses.

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglins folder, the

Mouse tool will appear as an addition to the standard tools.

~ 1
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Typical Workflow

The SmartAlign software is very flexible in how it is used, however, most tasks will follow a similar
workflow. These are summarized below and then discussed in more detail in the following

sections.

Data ® The first stage is the recording (or loading) of an
acquisition image series.

Dat ® This stage prepares the image-series for processing,
ala is used to trim the series, adjust the pixel-sampling
prepa ration and setup the options corresponding to different

acquisition conditions.

Ri d ®  Rigid-registration removes the translation offsets
18] between images in the series caused by stage /
reglstratlon sample drift.

Non'rlgld ® Non-rigid registration removes the affine and/or non-
regist ration linear distortions within each frame.

®  For drift measurement and compensation (optional)
the lattice base vectors must be identified. These

Second image

or Sl correction directions will also be used for and image line-profiles
used.

The plug-in is designed so that each stage in the processing creates a new data window for its
results. If for some reason the calculation fails, or the user wants to go back one stage and choose
a different setting, the new window can simply be closed and the result from the previous stage

will still be there.

The following examples will use the supplied example image-series of a SrTiOs; nano-cube edge to

demonstrate the various steps.
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Plug-in Menu

The figure below shows the menu for the SmartAlign plug-in:

Acquire Image Series...

Acquire Sl Series
Setup Stacked Image from Archived Data...

Prepare Data...

Rigid Alignment...

Non-rigid Alignment...

Align Extra Signal using Reference...
Align S| data using Reference...

Align 4D STEM data using Reference...
Repeat Alignment of the same Signals...

Remove Image Ramp

Crop Data

Show as Movie

Remove NR translation data
Compress EDX Data...
Decompress EDX Data...

Remove Spike Noise from S|

Help
About..,

Define Motif..,

Detect Motifs for

Non-rigid Motif Alignment for

Align Second Signal by Motif for

Align SI Data by Motif for

Clean-up Motif Detection temporary data...

About TM Module...
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Supported File Types

To begin, the user should have the file open within the Digital Micrograph workspace. To open a
file either open it from your computer or from within DM by going to File > Open. DM supports
images-series being saved as a single file (as slice data), however if the images were recorded as
separate files, they can be imported using the ‘File’ > ‘Open Series...” option to produce the stacked

data on import.

The plug-in supports all image formats supported by DM, however, it is strongly advised that the

images to be processed have received no image compression (such as JPEGs).
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Data Acquisition

Atool for the recording of series is included with SmartAlign.

i !

I:'t‘ Smart Align Acquisition

Control l Signal ]

Data Mame: |Test

Mumber of Images: l?
(7 Save each image to disk
(71 Create stacked image
@ Create stacked image and save numbered |1—

Folder: | C:\Folder_Mame

Browse Folder Directory ]

Magnification: | 100000.0

Image Dimensions: | 512

Pixel Dwel Time (us): | 4.0
Image Rotation: | 0,0 |:| 90 Degree Rotation
[ Line Synch

V] Rigid Alignment for [0:JEOL ADF1 | [setup |

[ save aligned stack to disk
[ save aligned average to disk

QK ] [ Cancel

‘Control’ Tab

Data Name

Here you can enter a filename that will assigned to the recorded image series. If the user chooses
to create a stacked image (see next section), and use the auto-numbering and save feature, each

filename will be created using underscores to concatenate the fields with the following format:

“on o on

“Data Name” + “_" + “Sequential Number” + “_" + “Detector Name”
For example:

My Sample Name_001_JEOL ADF1
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If you change to a new sample / region / experiment you can choose a new ‘data name’ and
reset the numbering by simply typing the next desired number. Numbers are given in a three

digit format.

Number of Images

This specifies the number of images in the series. After recording, the series can always be
trimmed. If the stability or damage tolerance of the sample is unknown, it may be helpful to
overestimate the desired number of frames. If damage or contamination is observed, then the

user can later decide to reject the later part of the series.

For a detailed discussion of how to optimise the number of frames in an experimental acquisition

for a fixed electron-dose budget, see the manuscript [4]

In addition to specifying the number of images, the user should choose whether to write the
images individually to disk or to display the images as a single stack (as slice data). In general, a
single stacked image is more convenient. However, if recording very large images, or an extremely

large number of frames it may be preferable to write directly to disk.
In the case of creating a stacked image, the user can further select to auto-save this file.

Folder
If an auto-saving option was selected, then images will be saved into the specified folder. Either

type to location directly or select the folder using the ‘Browse’ button.

Magnification
This will be automatically read from the microscope and added to the image series meta-data.
This does not need to be edited unless the user changed the magnification after opening the

acquisition menu.

Image Dimensions

This will be the height and width of the image measured in pixels. The recorded images are square.

Pixel Dwell Time
This sets the dwell-time for each pixel in units of microseconds. The time for one scan-line will be
the image width multiplied by this number. To adjust other time parameters such as the flyback

waiting time, use the advanced settings in the normal STEM Digiscan dialogue window.

Image Rotation

This sets the overall rotation of the scan, performing the same function as ‘scan-rotation’ in the
Digiscan settings. The scan-rotation of acquired data has an effect on the ease of processing the

series.
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For the rigid registration, the image alignment will make use of correlations calculated in Fourier-
space (more details later). To maximise the precision of this stage it is advisable to ensure that
when recording image series, the Fourier spots (including their cross shaped streaks from the finite

image border) do not impinge upon one another.

For the non-rigid registration, if a low-order crystal lattice plane is aligned to the fast-scan
direction, then often some scan-rows will contain only minimal contrast. As it is image contrast
which is used to identify and correct for the scan-distortion, it is preferable for scan-rows to not

be devoid of contrast.

Both of these conditions can be fulfilled by adding a small scan-rotation off of the crystal plane

(say 10° or so).

A further robustness to sample / stage drift can be incorporated by adding an additional scan-
rotation stepping of 90° between each image frame. In this case the images will be rotated back

when added to the stack.

Rigid Alignment for

If selected, an automated rigid registration can be performed immediately after the acquisition
has finished. This will only correct for image translation (whole frame offsets), however it allows
the images in the series to be summed for inspection. The user can then check, for example, the

sample tilt or image defocus.

If this option is selected, then one signal can be selected as the inspection signal. Other signals can

be registered later. The ‘Setup’ button allows for the rigid-registration settings to be adjusted.

To maximise workflow productivity, the outputs from this post-acquisition alignment can be
immediately saved to disk, with the option to also save the average through the series as a single

frame.
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‘Signal’ Tab
On this tab the user can select the signals to be recorded. If multiple signals are selected these will
be recorded simultaneously. Importantly, this means that the same probe-offset vectors will apply

to every signal.

In this tab the number of signals available to the Digiscan, as well as their names, will be

automatically detected.

I:'t' Smart Align Acquisition Iﬁ

Control  Signal ]

Qutput Signal: 0:JECL ADF1 4 hyte -
[]1:JEOL ADF2  |4byte =
[] 2:3EOL BF 4byte -

[7] 3:GATAN BF/DF

[] 4:Pulse 0 dbyte -

[7] 5:Pulze 1 dhyte

QK ] [ Cancel
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Data Preparation

The data preparation stage should be executed before any either of the registration stages:

Data Preparation | Rigid Registration | Mon-Rigid Registration ] Display ] Advance
[ ] select frame sub-set

First frame: |1 ~

Last frame: |17 =

[|Rreverse frame sequence
[ | Transpose data in x-y
Maormalise dynamic-range of data

[ ]rezample data: | 2.0

Scan-otation (90deg) between each frame: |None e
Scandine time: | 0.02 seconds; (for frequency calibration only)
Median equalise data (STM/AFM only): | Off w
0K Cancel
Data Shaping Options

In this menu the user can choose to select only a sub-set of the frames in the series. To do this
select the checkbox and then choose the first and last frame number (note frame counting here

is one based and not zero based).

The user can also select to reverse the frame order; this may be useful when processing or

comparing focal series.

The user can select to transpose data; this may be useful if the data has been imported from an

FEI *.ser file or from another package such as MatLab.
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Data Scaling Operations

Normalising the Data Grey-level Range

For most applications the numerical values of the STEM image pixels are not needed. In this case
the data may be scaled (subtracting some constant and dividing by another) with no loss of

gualitative information or relative contrast.

There are two reasons why the user may want to do this; for data with a large constant offset (for
example a large amplifier black-level) the data will have a large mean grey-level. This will give a
large DC offset in the Fourier based cross-correlations used for rigid registration. Subtracting a
constant reduces this offset term and may help with the rigid registration. Additionally, the later
non-rigid registration calculation is based on image intensity gradient matching and dividing the

range of the data by a constant may accelerate the calculation speed.

Note, if performing a quantitative analysis, where the pixel intensities do have real meaning, this

option should not be used.

Data Resampling

This option allows the user to resample the data in x-y before any onward processing. Resamplings
smaller than one will reduce the number of pixels in the image (more coarse sampling), and values
larger than one will increase the number of pixels in the data (more fine sampling). Reducing the
sampling may be useful for condensing data from large CCD cameras or to do initial quick
calculations on less powerful computers. Increasing the sampling may be useful to achieve digital
super-resolution. In general, increasing the sampling by more than, say, three or four will not lead
to any improvement but will slow the subsequent calculations significantly due to increased

memory usage.

Digital super-resolution is an advanced topic and a separate example is given at the end of this

manual.

Scan Metadata Options

Scan Rotation Between Frames

This option toggles different modes in SmartAlign depending on how the image series was
recorded. Specifically, it changes the ‘row-locking’ and ‘row-fitting’ behavior used in the non-rigid
registration options. Users should see the associated manuscript for a further description of the

‘row-locking’ and ‘row-fitting’ behaviours.
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Scan-otation (90deg) between each frame:

Scanine time: | 0,02 seconds; (for e orizontal scan first
Vertical scan first

The default setting is ‘None’, this means that no change in scan-rotation was used during the
experimental acquisition. Alternatively, SmartAlign can accept data with multiples of 90° scan-
rotation change between frames. For this data can be recorded as ‘orthogonal pairs’, that is
scanning at 0°, 90°, 0°, 90°... etc., or as an ‘orthogonal set, i.e. 0°, 90°, 180°, 270°, 0°, 90°... and so

on.

If either orthogonal type option is used, then the user should select whether the fast-scan
direction is horizontal or vertical in the first image of the series after any trimming of the series

and/or transposing has been applied from the earlier options.

Scan-line Time
Here the user can specify the time per fast-scan line. This is only used to calibrate the frequency

axis in the instability frequency analysis.

Median Equalisation (Tip Height Correction)
This is an advanced option which attempts to correct for STM/AFM tip height errors.

Median equalise data (STM/AFM only):

Row-wise medians
Global median

For STM/AFM image series exhibiting tip-height errors, the data can be adjusted in height to bring

each scan-row onto either a row-wise median, or global median height.

The default mode for STEM or TEM imaging is ‘Off’. The only exception to this would be for STEM
data recorded with a cold-FEG gun where the emission fluctuation compensation has failed (but

this is very rare).
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Rigid Registration

Selecting the Area for Rigid Registration
The Smart Align software can perform the rigid-registration in one of two ways; either on the

entire field of view, or on a selected ‘region of interest’ (ROI).

Full field-of-view (without ROI):

To use the full field of view, simply select the pre-processed data as the front window and then

select “Rigid registration” from the Smart Align menu.

- o

{5 F: Preprocessed 12cm - RevSTEM30 ADF2

5 D: Average Through Stack Rigid Aligned 12cm - RevSTEM30 ADF2 R ==

>

Using the entire image will yield an aligned image with the biggest possible field of view, but it
may take longer to compute. For low-dose data, where crystal fills the field-of-view, then using

the whole area is likely to increase alignment precision.

ROI Alignment

To use the ROl alignment mode, first draw a ROl on the pre-processed data using the DM ROI tool:

% Digital Micrograph
! File Edit Display Process Analysis Window Microscope
P ] A B SR gl P

Histogram v X
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You should ensure that the ROl is large enough to fully encompass the feature of interest in ALL
slices of the series data, not just in the first slice. You should inspect the slices before proceeding

to ensure that the ROl is large enough to include the feature after sample/stage drift.

54 F: Preprocessed 12cm - RevSTEMO0 ADF2 — e

B G: Aveage Through Stack Figi.. [ ][ ] 2]
Al

9

Where only one region of an image is of interest, then using a ROI rigid-align will generally be
faster. This may also be useful if trying to align very large datasets where memory use would be

an issue and a fiducial mark is present (see special FIB-SEM example at end of manual).

A hybrid of these approaches is to measure the image shifts on the smaller ROl data but then to
correct the image shifts on the full field-of-view; see the later section on “Aligning Extra Image

Signals”.
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Selecting the Rigid Registration Options
Each experimental dataset is unique; the rigid-registration menu contains options to adjust the

settings to get the best possible image alignment for any given dataset.

i Smart Align ¥

Data Preparation  Rigid Registration | non-Rigid Registration ] Display ] Advance ]
<Data pre-processing Options >
Apply filter: | Mone W
Window data in real-space (Hamming window)
<Registration Method =
Correlation function mode: | Square-root (MCF/0.5) ~ | | 0.5
Filter correlation spectra (Butterworth)
Estimate image offsets
(®) High 5/M data: Consider displacements up to |3_ (= 17) th nearest neighbours
(CJLow 5/N data: Estimate an average linear displacement

Refine image offsets: |2 cydes

<Qutput Options =
Fill the Backaground
() with Zeros
(®) with Average of other frames
Crop output to common area
Display output in new window (keep original)

Accumulated image: | Average

Ok Cancel

The rigid-registration menu is divided into three sections:

Data pre-processing Options

Data Filtering

If the image-series is noisy then image filtering may improve the reliability of the registration. Two
options are available; 3x3 median filtering and 5x5 Weiner filtering. Other advanced filtering may

be used and this special case is discussed with a special example at the end of this manual.

Data Windowing
For images which have crystal filling the whole field of view, cross shapes often appear centered

on the Fourier spots due to the abrupt edges of the image. These can affect the reliability of the

20
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image correlations and windowing the images in real-space may improve this. A Hamming window

can be selected here.

Registration Method
Rigid registration is achieved in SmartAlign using correlation functions. Three specifically named

correlation functions (between two images g and h) are shown below:

The cyclical cross-correlation:
Corr(g,h) = F~* (F(g) o F(h)*) (1)

The mutual-correlation function (MCF) [5]:

MCF(g,h) = F~1 <—F(g)°”")* ) 2
(g.7) F@) ek | )

The phase-correlation function (PCF) [6]:

_ -1 ( F@eFH)
PCF(g, 1) = F7* (5 ) @)

More generally these can be expressed as a continuum set where the exponent on the
normalising denominator, a, is a variable between zero and one [6]. Hereafter, for generality this

will be referred to as the normalised correlation function (NCF):

_ et [ F@ery
NCF(g; h) =F ( |[F(g) OF(h)*|a) (4)

The need to consider modifying the power on the normalising denominator lies in the
range of specimens that may be needed to analysed. For example, specimens with very ‘bland’
crystallography, such as a constant thickness slab of Si[110], will require the registration to be
achieved entirely using the non-periodic information so a larger value of a would be
recommended (say 0.75). However, a free standing metallic nanoparticle free from contamination
can be registered very accurately considering the silhouette of this periodic information, so a

lower value of a would be most suitable (say 0.2).

Finally, if both the images being compared are noisy, the resultant correlation functions can

themselves be noisy and an additional option to filter these with a Butterworth filter is provided.

Once the user has selected which filtering and correlation function options will be used, there are

two further choices; how the offsets will be estimated and whether the offsets will be refined:
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Estimating the Image Offsets

Estimate image offsets
(®) High 5/M data: Consider displacements up to | 3 (< 17) th nearest neighbours

() Low S/M data: Estimate an average linear displacement

Refine image offsets: | 2 cydes

Here there are two modes, optimized for both high signal-to-noise (SNR) data and low-SNR data.
For the majority of datasets, the high-SNR mode should be used, and only for the most noisy data
is it necessary to use the low-SNR mode. If the image contrast is sufficient that the stage drift can
be observed by the naked eye, then it is recommended to use the high-SNR mode. The low-SNR
mode should only be used where the dose is so low that the stage drifts are not distinguishable

by eye.

High SNR Mode:

In the high-SNR mode it is assumed that the correlation functions setup with the previous options
will estimate the offset between images accurately but potentially imprecisely. To mitigate this
the rigid-registration stage of the SmartAlign plug-in does not have rely on any one measurement
to determine the offsets. Instead, when determining the image offsets, each image can be
analysed relative to its direct neighbours in the image series, then its second nearest neighbours,

third-nearest etc.

Here the user can select the number of nearest neighbours to use; the minimum is one, in which
case each image is only compared with the previous one, up to (n-1), where n is the number of
images in the series. To help the user the menu will indicate the maximum number that can be

selected alongside the option.

Increasing this number excessively will increase calculation time with diminishing gains in
precision. Additionally, in the presence of gradual structural changes, such as beam-damage,
including ever further afar neighbours may reduce registration precision. A typical selection would

be three or four nearest neighbours.
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The example below shows the result of computing the offsets for the first 4 nearest neighbours.

::.:: J: Multi-pair alignrment EIIEI

Horizontal Offsets

The figure shows three plots the horizontal offsets between the images, the vertical offsets, and
the similarity between image pairs. Each value is plotted in the lower half (triangle) of the matrix
representing the ith-jth images. The similarity matrix can be useful in determining the number of
nearest neighbours to include, if the similarity begins to drop, this indicates that the images are
no longer similar enough and would not improve (or possibly worsen) the precision of the offset

estimation.
Once the matric of neighbour data is compiled a mutual solution is determined.

Low SNR Mode:

In “Low SNR Mode” the image series data will first be condensed into four subsets to improve the
SNR of low-dose images. If the rate of linear stage-drift is relatively constant, the sample drift
between image 1 and image 5, should be approximately the same as between image 2 and image
6, and so on. This gives redundant observations of the same drift-rate and allows for a more

precise estimate to be achieved for noisy images.

After the four subsets have been analysed to determine the overall drift-rate, the offsets between
these corrected four sets of data are analysed to correct for any shifts induced by any 90° image

rotations used.

Together these two information describe all the shifts, the images are realigned and can be refined

as described in the next section.

Importantly, this mode is only applicable to image-series recorded in a single acquisition. If the
series is generated from joining together two or more shorter series, then the prior knowledge of

the monotonic drift behaviour may not be valid and this method will not be suitable.
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It is also recommended to consider windowing the data in real-space (Hamming window option)

if you have a very large offset of the scanning rotation origin.

Refining the Image Offsets

Using the image-offsets estimated from the previous stage the image series can be realigned. The
average of this realigned series will have a higher SNR than any one image alone. Next, the user
can reanalyse each individual image relative to this average image, and the offsets nay be able to
be improved. This procedure is somewhat iterative and the use can decide how many attempts

should be made to refine the offset estimates.

I:"‘-‘_' I: Image offsets E\@

104

04 IxshiFt[muIti_pair_rigi:l}I
=10 IvshiFt[multi_pair_rigid}I
—204 I x shift {refined) I
-304 | vshift (refined) |
—a04
-5
—504
-704
—g04
~504
-1004
-1104 !

] 2 4 6 g 10 1z 14 16

A typical value might be two refinements; selecting zero will skip this stage.

Output Options

Once the image offsets are refined a new window with the results will be output.

<Qutput Options =
Fill the Backaground
() with Zeros
(®) with Average of other frames
Crop output to common area
Display output in new window (keep original)

Accumulated image: | Average

Where shifts exist between images there are two choices to output the data; firstly, the canvas of

the data can be expanded to incorporate the image drifts (results in a bigger size image series), or
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the data can be cropped to only keep the physical area common to all frames (results in a smaller
image series). The user can select which option they want with the “Crop output to common area”

checkbox.

If the user selects not to crop the data, they will expand the canvas; in this case there is an option
of what to fill the extra area with. This can be filled with blank (zeros) or it can be filled with the
average of all non-zero observations from that position. The former option is useful for viewing
the image drift and observing changes in the illuminated region of the sample; the latter is useful

for a more ‘panoramic’ option, attempting to maximise the field of view.

In addition to the image series being output, the accumulated image is also shown after
processing. The final option in this section determines whether the average of the frames is

shown, or the summation.

These rigid-registered results can be saved at this point, it is not necessary to continue to the non-

rigid calculation, as this can be resumed at a later time.
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Non-rigid Registration
After finishing the rigid-registration, non-rigid registration can be performed. Before beginning

the non-rigid registration, if it is not already, the results from the rigid registration should be

selected to bring it up as the front window.

i Smart Align X

Data Preparation | Rigid Registration Mon-Rigid Registration l Display ] Advance ]

Iterative Registration Cydes:

Initial affine-only cydes: | 2

Advanced non-igid cydes: | 4 - select method below:
(®) Lodk scan-rows together
(_J Fit rows with polynomial: Linear e

() Use unconstrained smoothing
Smoathing kernel size{pin-FWHM): |8
Convergence criterion: | Mormal 1| 1.0e-5

Convergence acceleration: | Mormal 1|70

Keep MR translation data
Reference Image Choice:

(®) Average of al frames

[ ] Use nearest neighbour average for first | o cydes
() Fixed image | 1 th frame
Qutput Options:

Display output in new window (keep original)

Accumulated image: |Average v

o4 Cancel

This menu is divide into three sections, with options related to the iterative registration cycles,

the choice of reference image to use, and for the outputting of the result.

The Types of Iterative Registration Cycles
Since the SmartAlign algorithm does not enforce any prior knowledge on the expected symmetry
or appearance of the sample, the registration runs iteratively, converging towards the ground

truth. These iterations are broken into two types and can be selected separately or together.
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Iterative Registration Cydes:
Initial affine-only cydes: | 2
Advanced non-rigid cycles: | 4 - select method below:

() Lock scan—ows together
(®) Fit rows with polynomial: Linear e
() Use unconstrained smoothing

Smoathing kernel size{pin-FWHM): |8

The first type is to correct the scan-distortion using only affine transformation. This type of
transformation is a ‘linear non-rigid transformation’. Linear, because any straight line feature
before correction will be preserved as a straight line afterwards, and non-rigid because different
pixels can move by different amounts in x and y. Using this type of iteration the user can correct

for image shear, scale, and (small) rotations.

As every pixel in the field of view is used when calculating the affine transform for every frame (6

parameters), this type of correction is very robust to image noise.

The next type is the “Advanced non-rigid cycles”; these are the fully non-linear non-rigid iterations.
‘Non-linear’, because now straight lines are no longer required to be preserved. Unsurprisingly,

non-linear transformation is necessary to correct non-linear distortions.

The Number of Iterative Cycles

In the majority of cases few affine type cycles will be required. However, if scan-rotation between
frames is enabled or if the drift rate of the stage is varying over time then more may be necessary.
Fortunately, these affine calculations are computationally very efficient so a default of say 2-cycles

is a good starting value to try in most cases.

The full non-linear calculation is more computationally intensive. For quick calculations to check
the quality of data two cycles may be sufficient. For a more final analysis a typical number might

be four cycles.

Types of Non-linear Cycle

The SmartAlign algorithm offers three types of non-linear iterative cycle. The first of these is the
so-called ‘scan-locked’ mode. This is described in more detail in the SmartAlign academic
manuscript. In brief, this mode maximises the artefact robustness of the algorithm by utilising the
prior knowledge that the STEM is a scanned instrument. This mode is also applicable for

STM/ADF/SEM etc. For serial microscopes this is generally the most appropriate mode.
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In some cases, where the sample is rotating slightly in the plane (not tilting) then row-locking will
not describe this additional motion. For this case ‘row-fitting’ should be used. This allows for the
benefits of row-locking, but also allows an additional degree of freedom to describe the rotation.

A typical use case for this mode might be nanoparticles loosely attached to a substrate.

The final mode available is the fully unconstrained mode. This is most suitable for parallel acquired

data such as conventional TEM and photographic data.

Smoothing Kernel Size

After selecting the type of non-linear cycle, the user must specify a smoothing kernel size.

There are two reasons why a smoothing kernel is used to constrain the diagnosed transformation
fields. Firstly; it is not physically realistic for the diagnosed transformation fields to contain abrupt

discontinuities and so a small smoothing is justified to remove noise.

Perhaps more importantly, and mostly when using the unconstrained (TEM) mode, it is important
that no crystallography is observed in the transformation fields. Remember, the transformation
fields are only a description of the environmental distortions affecting the data. As the distortions
do not depend on the sample under observation, then these should not exhibit signs of crystal

periodicity.

Remember adding a small scan-rotation, and using row-locking will improve STEM (row-locked)

series processing.

Registration Convergence - the Target, Acceleration & Number of Cycles
As the SmartAlign software solves for the image distortions iteratively, success is determined by
the measurement convergence. Three inter-related factors contribute to this convergence

behaviour.

The Convergence Target

The convergence target specifies the exit criterion for the innermost iterative loop. It has units of
the average magnitude of pixel shift in the frame. The preset options range from weak-
convergence (average shift of 10 pixels) to a strong criterion of 10 pixels. The user can also

specify a custom number.

The Convergence Acceleration
The convergence acceleration determines the aggressiveness of the iterative correction. A higher

number will increase calculation speed but if the number is too high, and the data are noisy, then
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the convergence may become unstable. In this case a warning message will be displayed and the

software will attempt to ‘self-heal’ buy reducing the acceleration by 10%.

The weak setting yields an acceleration of 2 through to a value of 20 in the strong setting. The user

can also specify a custom value.

The Total Number of Iterative Cycles

Adding together the number of affine-only and non-linear registration cycles yields the total
number of iterative cycles. The final convergence criterion target specified above is not reached
immediately, but rather the strictness of the criterion is approached gradually and reaches the

ultimate target value at the final cycle.

Storing the Transformation Data

If more than one image signal was acquired, then the probe-offset data can be transferred from
one diagnosis to correct other signals. If this is the case, then the user should check the ‘Keep NR
translation data’ box. When this translation data is stored, it is stored in the image metadata for
later use, the data can be used to compensate a second signal immediately, or the file with its
metadata can be saved and the translations used at a later date. In this case the file size will be
larger by approximately a factor of three (the original image data, and two new metadata with

equal dimensions describing the shifts in x and y).

Choice of Reference Image

The user can choose which reference data is used as the comparison image.

Average of Frames
For the majority of cases the best reference data will be the average of all frames in the series. In
this mode each image will be compared with the average when diagnosing the shifts. At the end

of each cycle the updated frames will be used to make a new average reference image.

When the image distortions are large, however, an average of all frames would cause an excessive
degradation in reference image quality. In such a case, a local average of the images immediately
before and after each image in the series can be used as the reference for first few cycles. This

option can be activated by selecting ‘Use nearest neighbour average’.

NOTE: An alternative use for the local average reference method is the processing of dynamic
movies such as in-situ data, where the underlying sample is genuinely transforming and an
average of all frames would not have a physical basis. In this case some distortion correction

is still possible while maintaining temporal resolution.
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Fixed Frame

An alternative to using the average frame is to specify a particular frame to use as the reference

for all others.

Output Options
Here the user can select to open the results in a new window and keep the original open (the
default behaviour). In general, it is only necessary to deselect this in computers with very limited

memory or with very large datasets.

The user can also choose here how to output the compound image after processing. In general,
the ‘average’ image is the most suitable (including for fractional ADF or STM/AFM height data),
but a ‘summation’ image may be useful if the data represents counts or some other quantity you

wish to accumulate.

The Progress Bar
After choosing all the appropriate options, pressing “OK” will start the calculation. During the
calculation a progress bar will be shown, as well as some more detailed text based readouts in the

Output window.

SmartAlign *
Refining image-offset estimates

iteration number: 4

Cancel

The calculation can be aborted if necessary by pressing the “Cancel” button. In this case a

confirmation dialog will be displayed:

DigitalMicrograph X

o Do you really want to stop processing?
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In this case only the currently running non-rigid calculation will be aborted. The existing rigid-
registered result will remain in the workspace. The NR calculation can be started again, or the rigid

results saved at this point and the calculation continued later.

The NR Outputs and Image Cropping

After the NR registration is complete, and depending on the severity of the drift and distortions,
pixels shifted from outside the scanned area will appear around the edge of the frame as grey
pixels. It may be necessary to crop one or two pixels from around the perimeter. This can be done
by selectin the ROI tool from the toolbar and then selectin the ‘Crop’ command from the

SmartAlign menu.
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Aligning Extra Image Signals

After an alignment has been performed (either rigid or non-rigid), then this can be further applied
to another image signal so long as the data were acquired simultaneously. If the data were not
acquired simultaneously then the drifts and probe distortions will not be equal and this is not

applicable.

To do this select ‘Align Extra Signal using Reference...” from the main menu.

l:'1‘-‘_' Align Second Signal >
Reference signal: | D: Mon-rigid Aligned ADF Time Series =~

Target signal: | I: ABF Time Series A
Median equalise: | Off e

0K Cancel

Here for example the diagnosis from the registration of an ADF series is copied to an ABF series.
After pressing OK, both the new aligned signal will be displayed as well the average of the new

series.

Rigid Registering Additional Signals
In the case of rigid alignment, if the alignment was performed on a reduced ROI, then the user will
be asked whether to use these image shifts for the whole image, or to again return only a reduced

ROI:

% Align Second Signal X

Apply rigid alignment for
(®) the same area
() the whole image

oK Cancel

If the user selects “the same area” then the same area as the ROl used on the first signal is
returned, if the user selects “the whole image” then the whole image is alighed and cropped to

the largest possible common area.
Non-rigid Registering Additional Signals
In the case of NR registration, it is only possible to return the same field-of view, and the above

choice will not be presented.
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Repeat Alignment of Similar Data-sets

Where many data-sets are recorded in an experimental session, it may be convenient to align all
of these afterwards using the same settings. This will generally be suitable where the same (or

very similar) magnification and pixel size has been used with the same detectors.

This automated processing can be left unattended and is accessed under the following menu:

Repeat Alignment of the same Signals...

Help

Acquire Image Series...
Acquire Sl Series
Setup Stacked Image from Archived Data...

Prepare Data...

Rigid Alignment...

Non-rigid Alignment...

Align Extra Signal using Reference...
Align S| data using Reference...

Align 4D STEM data using Reference...
Repeat Alignment of the same Signals...

Remove Image Ramp

Crop Data

Show as Movie

Remove NR translation data
Compress EDX Data...
Decompress EDX Data...

Remove Spike Noise from SI

Help
About..,

The working principle here, is first that one data-set should be reconstructed as previously
described above to determine the user settings as desired. These user settings will be stored in
the metadata of the aligned image. On selection of this ‘Repeat Alignment’ menu, the same

alignment settings will be read from this metadata and then reapplied to the selected files.
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The options needed to perform this repeated alignment can be specified in the dialog shown

below:

Repeat Alignment »

SEE =Tl H: Monigid Aligned Sample -

Target signals: Mumber Target Signals: 2

Sample1.dm3

Cutput folder (when zaving the result)

@ Same folder of the tareet =ign...

O REENEEN C¥Data¥Plugin Demo Data¥Smart Align¥ TME

W Dizplay Averaged Ima...
Auto
Dizplay Accumulated im..

H 2uto

Description of Options

e Here, the user should select the ‘Reference signal’ — this is the data-set that has already
been aligned and from which the metadata will be read.

e Next, the user should click ‘Browse’ and navigate to the additional data to be aligned.
CTRL+click can be used to add each clicked data, or SHIFT+click to select a range of
multiple data.

e The next option allows the user to specify that the process data should be recorded back
to either the same folder as the raw data or to specify a new location.

e The final options, also allow for the display and/or saving of either the averaged image or

accumulated image.

Where a large number of data-sets are being processed (e.g., overnight), please ensure that the
disk drive being used will have sufficient space for the outputs. Additionally, where the repeated
alignment is wholly unsupervised or where a very large number of data-sets are being processed,
the option to display the outputted images can be disabled to avoid unnecessary memory usage

by DigitalMicrograph. The saved results can instead be reviewed later (e.g., the next morning).
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Aligning Spectrum Image Series

If the image series which has been aligned represent the simultaneous image frames
accompanying spectrum image acquisition, then the probe offsets can be copied from the image

series to the series of spectral volumes.

First all the steps above should be completed; during rigid alignment cropping should be selected,

and during non-rigid registration the option to keep NR translation data should be selected.

With the aligned image series selected as the front window, select ‘Align SI Data using Reference...’

from the SmartAlign menu.

A file explorer window will open and you should select all the spectral volumes that match the
image series. The spectral volume series will be read into DM in the order based on their
filenames. For example, adding numbers or letters to the Sl filenames will help them be read

correctly. The example here shows an 8-frame image series and 8 spectrum images selected.

i Align Sl Data X

Reference signal: | D: Mon-rigid Aligned 003_HAADF_&frames

Target signal: 003a_FELS_SI_Ap3mm_fullrange
Selected SI Data: 8
[ ]trim frames

first frame: | 1
last frame: | 2043

QK Cancel

The size of the spectrum images in the third dimension (number of channels) will also be
displayed, and if necessary, a reduced range can be reconstructed to minimise RAM usage by

selecting the check box “trim frames” and specifying a range of channels (frames).
You should verify that the correct reference data is selected and press ‘OK’.

While the Sl realignment and NR registration is running, an integrated spectral view will be shown
as well as an integrated spatial view. These are not interactive and are just visualisations to

monitor the progress. Once complete the corrected spectral volume will be displayed.
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Post Summation Data-type Verification
Depending on the type of multi-frame spectra that are ultimately summed, it may be necessary
to check the data type. If the wrong data type is selected, this can be corrected by selecting:

Spectrum > Convert Data To, and choosing your desired data type from Spectrum menu.

pe | Spectrum | EELS SI IPU Jitterbug Volume
E Convert Data To ’ None &

Overlaid Spectra »

Splice > :

Numerical Filters >

MLLS Fitting b

NLLS Fitting 4

Report >
__




SmartAlign Plug-in User Manual

Aligning 4D-STEM Data Series

(This command requires the 4D-STEM module license)

If the image series which has been aligned represent the simultaneous image frames
accompanying 4D-STEM acquisition, then the probe offsets can be copied from the image series
to the series of diffraction volumes. Where a conventional imaging detector is not used during 4D-
STEM acquisition, then an image series synthesised from the 4D data itself may be used as the

diagnostic image series.

First all the steps above should be completed; during rigid alignment cropping should be selected,

and during non-rigid registration the option to keep NR translation data should be selected.

With the aligned image series selected as the front window, select ‘Align 4D STEM Data using

Reference...’ from the SmartAlign menu.

Then, a file explorer dialog will open where you should select all the files that represent the 4D
volumes associated with the series. The below example shows the result of selecting 6 data

volumes.

B
Reference signal:  B: Non-igid Aligned Trend Subtracted 4D-STEM_series_VHAADF-stack

Target signal: 4D-STEM_series_01_cropped
Selected 4D STEM Data: 6
[] Output 4D STEM Separately

OK Cancel

A checkbox ‘Output 4D STEM Separately’ will be shown giving the user the option to ‘Output 4D
STEM Separately’. If selected, this will align and non-rigid register the 4D volumes in the spatial

dimensions, but will then store them to disk separately.

During the registration process (which may take some tens of seconds depending on the PC
performance), the user will be shown the current 4D data being processed as well as the

cumulative data processed up to that point:
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Once the processing is completed, the 4D volume data is displayed. This is a 4D data and may be
inspected using the Sl Picker tool. (If you don’t have Gatan S| Picker Tool, the HREM Picker Tool

can be download from HREM Research home page.)

At this point, the 4D-STEM data may be saved and/or exported to another package for onward
analysis.
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Additional Menu Items

There are two further tabs containing output display options and the advanced settings.

Output Display Options

This tab allows the user to display more or fewer additional diagnostic figures during processing.

g Smart Align ¥
Data Preparation ] Rigid Registration | Non-Rigid Registration  Display l.ﬁ.duance ]

Message Level: | Mormal e
Output figures:
Rigid Registration:
Image offset
Multi-pair alignment
Finding long-range drift
Condensing low-dose data for alignment
Mon-Rigid Registration:
Maving image
Reference image
Distortion field

oK Cancel

These options include a choice for the granularity of text message outputs (displayed in the DM

results window) during processing, as well as the additional graphical display of variables.

These settings are saved when the registration is begun and will be preserved after DM is closed

for the next time.
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Advanced Options

This menu contains settings that rarely need to be changed.

i Smart Align e

Data Preparation ] Rigid Registration ] Mon-Rigid Registration | Display ~Advance
Mon-Rigid Reqistration:

max_nr_itts: | 250

[] constrain_edge

pre_smooth_moving: IT

pre_smooth_static; IT

noise_constant: Ir

debug_mode: |0

Ok Cancel

These options can be used to set an upper limit for the maximum number of iteration per image
in the innermost correction loop. Reducing this number may increase calculation speed but if

reduced too far may stop the calculation from converging fully.

In the case of an image series with a featureless background, then constraining the edges of the

transformation field may improve algorithm convergence.

In the case of very noisy data, a small smoothing can be applied to the individual images or to the

average reference image.

The noise constant controls the robustness to extreme outlier image pixels. A larger number will
increase robustness but at the expense of reduced sensitivity. This number should in general not

be changed.

The debug mode setting is only used for remote support use.
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Spectrum-Image Acquisition Menu

From SmartAlign version 2.1 onwards, a menu to assist with the recording of multi-frame
spectrum-image (MFSI) series is included. These options are found under the menu “Acquire SI

Series”:

SmartAlign

= Acquire Image Series... lﬁ% T et (O 82 5
Acquire SI Series 4 Cpen Acquire Window...
Setup Stacked Image from Archived Data... Setup Options...

Prepare Data.. Setup Advanced Options...

About..

Rigid Alignment...

Mon-rigid Alignment...

Align Extra Signal using Reference...
Align SI data using Reference...

Repeat Alignment of the same Signals...

Remove Image Ramp

Crop Data

Show as Movie

Remove MR translation data
Compress EDX Data...
Decompress EDX Data...

Remove Spike Moise from S0 3

Help
About...

Define Motif...

Detect Motifs far 4
Mon-rigid Motif Alignment for 3
Align Second Signal by Motif for 4
Align SI Data by Motif for 3

Clean-up Motif Detection temporary data...

About TM Module...

What the SmartAlign Spectrum-Image Module Is and Isn’t

The spectrum-image module does not itself add functionality to the base installation of
DigitalMicrograph. To capture spectrum-images in DM, users must already have those signals
available. What the SI module does add, is a data-saving helper to automatically capture, save,

and close from memory sequential Sl scans.

The Workflow of using the SI Module
The SmartAlign SI-module comprises of one main dialogue, plus two further settings menus. The
main menu comprises of three buttons for data-recording, plus an acquisition planning tool that

can be used to predict the experiment duration and electron-dose exposure.
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Before using the MFSI acquisition menu, the settings for the experiments should be prepared.

Setting up a MFSI Acquisition

As the SmartAlign MFSI module automatically captures and saves data, the settings for the data

saving (file location, file-type and signal choices) should be specified in advance. This is done using

the “Setup Options” menu:

t‘~‘-:‘ Options

Save Folder

C:\Folder
Disk Write Time (s) 0.5

Saver Helper
Detectors

V| Analog0 [V]EDS
[Tlanalog 1 [T]EELS
(| pual EELS

Spectroscopy

[“lpulse 0
[ pulse 1

-Dose Calculator
DigiScan Initialisation Time(s) I 0.05

[ OK ] [ Cancel

|

Using the “Browse” button the user should select the save location. You may create a new folder

if a suitable one does not exist. It is recommended that a local drive (ideally with a good disk write

speed) should be used. Use of a network drive with poor speed or latency may delay data-saving.

At the same time, the signals to be saved should be specified.

*Note — these settings are dictating which signals will be saved, and not which ones will be

acquired. To ensure the data is available to be saved, the user should verify these settings match

those selected in the Gatan SI menus (see following figure).
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[VeDS
[T1eELS

Scan Corrections
[~ spatial Drift

Scan Options
[¥] Acquire DigiScan signal(s)
[ Apply sub-pixel scanning
Data Management
[] Auto-Save data

DigiScan Signal Selection

Signals
[¥] Analog 0
[Tl analog 1
[Tlpulse 0
[“IPulse 1

[ ok | [ cancel |

data” should be set to off.

*Note — in the Gatan SI menus, “Number of Passes” should be set to 1, and the Gatan “Auto-Save

The SmartAlign “Setup Advanced Options” menu contains less commonly used settings such as

which version of Gatan file format to use, and EELS energy shift options to achieve either Binned

Gain Average or custom dark-reference experiments [7,8].

g Options

NOTE: Advanced Options requires

the SmartAlign License
—Spectrum File Type
VlGMs @ .dm3 ) .dm4

[ Ibjx

~EELS Options
E-shift after each frame

Number of Channels | 1.0
Max Spectrum Shift (Channels) | 0.0

—Execute on Finish
[C:\Defauit MFSTFc [Browse
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Performing a MFSI Acquisition

The MFSI acquisition workflow follows the following steps for each region of interest within an

experimental session. The user should first have a Digiscan image open of their sample, and should

use the Gatan SI menu to ensure this is assigned as the active image with an active ROI.

-

r.a: D: SI Survey Image (active) o |[@][=

t.-.—_- Acquire SI Series [__c::~ =) ]@

Confirm Acquisition Planning

[ Acquire SI Frames ]

Acquisition Planning
SIRange (nm): 84 x 90

Pixel Range (i | 3.0

SI Size (pix): 28 x 30
Dwell Time (s) |0.5
No. Frames ’T

Pixel Charge (e-): 5.61736e+007
Est. Frame Time (s): 420
Frame Dose (e-/A~2): 6.24151e+006
Est. Series Time (s): 2100
Series Dose (e-/A~2): 3.12075e+007
Series inc. Overhead (e-/A~2): 3.12823e+007

Recalculate

With this active image and ROl assigned, the three buttons guide the user through the process.

1)

2)

After navigating to a new region of interest in the sample, the first button prompts the
user to create a new sub-folder to store data in. This will be a subfolder for the site of
interest within the folder already specified via the settings menu. In this subfolder the
numbered images and SI will be stored with automatic sequential numbering in the
filenames. Users should avoid changing the filenames to avoid unintended reordering that
may be relied upon later during the data registration. If the user creates a subfolder with
a name that has already been used a warning will be displayed and the user should select
a different subfolder name. Reusing the same name may lead to data being overwritten.
At this point the size, shape and position of the ROI can be adjusted. Next, the user should
specify/confirm the pixel-step which will be used, as well as the dwell-time and number
of frames. If any of these parameters are changed, the user should press the ‘Confirm
Acquisition Planning’ button to update the settings for their acquisition. In this planning
menu the pixel-size is used to determine the number of pixels needed to cover the desired

ROI, and then using their dwell-time, to estimate the time needed per frame. With
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multiple frames, a total time for the whole series is also estimated. In addition, if the
beam-current is specified, then various dose prediction are estimated as well. If any
parameters are not suitable (or are left blank) the user will be warned before beginning

the automated acquisition.

DigitalMicrograph

\'@] Some parameters are not valid for Acquisition

3) Once the acquisition parameters are confirmed, the user should press ‘Acquire Sl Frames’.
This will begin the acquisition, saving and closing of the specified number of frames. Once
the acquisition has begun, it is possible to stop the acquisition by pressing ‘Stop

Acquisition’. This will abort the current frame in progress:

e

= Acquire SI Series (o ][@ =]

Stop Acquisition

Acquisition Planning
SIRanae (nm): 32 x 32

*Note — both in terms of the time prediction and the dose prediction, these are more accurate
where hardware synchronisation is used. Where software synchronisation is used, significant
additional communication overheads may exist and this will increase the time and dose required

to achieve the same results.
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Recording Additional Frames

After recording the specified number of frames (5 frames in the example screenshot above), it
may be that the sample remains undamaged / free from excessive contamination. In this case,
additional frames can be captured with the images and spectra continuing to be added to the

numbered series in the same folder.

r

iz Acquire SI Series o |[@] =]

Create Subfolder
Start View

[ Continue Acquisition ]

Acquisition Planning
SIRange (nm): 32 x 32
Pixel Step (nm) |2.n

In this case, the user will see the button change to “Continue SI Frames Acquisition”. The series

numbering will be reset when the user again presses “Create Subfolder”.
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Special Case Examples

Digital Super-Resolution Example
Consider the example ADF image-series below of a perovskite grain boundary with 16 frames with
512x512 image pixels each. This has been recorded at high-resolution but with insufficient pixel-

sampling.

Enlargement

The FFT shows spots are visible right out to the Nyquist limit, and the highest observable spot is
the (220) spacing (approx.. 1.38A. A 64x64 pixel RO is enlarged on the far right — again, not how
the sampling is too low. Ordinarily this would be a poor choice of setting to record the image; we
would usually increase the number of pixels or reduce the field of view (increase magnification).

However, both these options would increase the total electron-dose over the sample.

With this data, angle-measurement, structure matching, peak-finding or strain-mapping would be
very challenging. To overcome this, we will increase the sampling of this frame-series in post-

processing using digital super-resolution.

Note: this is not optical super-resolution, where the resolution is extended beyond that of
the original STEM probe, but rather this is digital super-resolution where the image-series

average will contain more discernible information that any one frame at the low sampling.

To do this select “Resample data” in the “Prepare data” menu. For this example, we will use 3x.

Now the data should be rigid, and non-rigid registered as normal.

The results below show the lower-right part of the image after resampling and alignment, the
reduced Fourier transform (central 50%), and a cropped enlargement of the same region as in the

earlier figure above.
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Enlargement

After processing the (331) spot is visible (approx. 0.9A resolution), and the detail in the interface
become clear. The recovered resolution is likely slightly poorer than had the image been recorded

under optimal sampling conditions, but it is an improvement on the raw data.

Note: the data-resampling must be done before the rigid and non-rigid registration to

achieve the digital super-resolution. Doing it afterward would just be a simple image scaling.

Below shows further enlargements of the before (single-frame) and after (average-frame) data.

B e ass412) [ (&R ]| | B Cro erage Thiough Stack Non-rigid Aligned 3« Super... [ (& ]2 ]

Going beyond 3x data-resampling will likely offer little benefit and will mostly just add to the

calculation time.
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Processing STM & AFM Data

For many scanned probe microscopy (SPM) datasets, it is often necessary to first remove a planar
ramp background. This tool is provided as a utility in SmartAlign and can be done at any point.
However for best results, it is recommended to perform this step at the start of the data

processing.

With the data loaded and stacked to create a series, select “Remove Image Ramp” from the main

SmartAlign menu:

Filters | Smartalign | Help

% () Acquire.., HRTI-

Setup Stacked Image from Archived Data...

Prepare Data...
Rigid Alignment...
Mon-rigid Alignment...

Align Second Signal...
Align 51 Data...

Remove Image Ramp
Crop Data
Show as Movie

Remove MR translation data

Help
About...

If a single image is selected this will operate once, if a series is selected, every image in the series

will have a ramp calculated and removed.

The result will be similar to the example below:
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( ntr_- C: Si (7x7) Empty States » | § :l:'t' A: Si (7x7) Empty States Ran:lp Rem(_)ve E”E@ )
» - - '
2 .
SRl
- -
i ve 3 2%
- » *
- -
-
o .
- -
~ile
-
- -
- i

Note: the range (height data) in the image is preserved, and the ramp is subtracted such that the

new image minimum is zero.

After the ramp removal is complete, you can continue to process the data as usual.
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Advanced Filtering for Rigid Registration
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Template Matching Module for SmartAlign

(This module requires an additional license)

Introduction

Template matching is a common technique that involves searching for repeating regions within
an experimental image of a crystal sample, and averaging them to improve image quality.
However, the “Template Matching Module” (TM module) for SmartAlign adds further
functionality, namely it includes non-rigid registration of the repeated image-regions. Thus, the
TM modaule is extremely suitable for data that has been acquired by scanning techniques, such as
STEM or SPM. Moreover, the same non-rigid registration information can be applied to other data
acquired simultaneously, such as Spectrum Images (SlI). Furthermore, the TM module enables the
operator to easily perform template matching over multiple data (image frames) saved in the

same folder to improve the data quality substantially.

This section describes the optional “Template Matching Module” (TM module) add-in for
SmartAlign. When the license for the Template Matching Module is activated, the commands for

the TM Module will be added below the SmartAlign menu commands as shown below:

|
ters | SmartAlign | Help

| Acquire...

H

Setup Stacked Image from Archived Data...

Prepare Data...

Rigid Alignment...

Mon-rigid Alignment...

Align Extra Signal using Reference...
Align 51 data using Reference...

Repeat Alignment of the same Signals...

Remove Image Ramp

Crop Data

Show as Movie

Remove MR translation data
Compress EDX Data...
Decompress EDX Data...

Help
About...

Define Motif...

Detect Motifs for

Mon-rigid Motif Alignment for Menus for
Align Second Signal by Motif for

Align 51 Data by Motif for

* ¥ ¥ v

Template Matching

Clean-up Motif Detection temporary data...

About TM Module...
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Template matching searches an experimental image for regions that repeat and extracts those
regions to yield a series of matches. Here we will refer to the reference, the patch which we search
for, as the “motif” and the extracted cropped regions as “tiles”. Once a series of tiles has been
extracted from an image, this series of observations can be considered as if an experimental
frame-series itself and is eligible for processing using SmartAlign in the usual way. This section of
the manual then, describes the process of extracting this series and how to prepare it for onward

processing.

Note: The TM module requires an independent license in additional to the SmartAlign license.

The license for the TM module will be added remotely using Remote Update System (RUS).

Template Matching across a Series of Images

When using template matching on image-series data, the user can choose whether to align that
series first and then extract the TM tiles, or to extract the TM tiles first and then align (distortion
correct) those tiles. The two cases are not quite equivalent, and the choice of which to follow
depends on the user’s experimental data and goal. These two work-flows are described in more

detail below.

Template Matching followed by Non-rigid Registration (TM - NRR)

If your image series is of a good SNR and contains only a few repeats of the motif of interest, then
performing the NRR across the full field of view would add calculation time for little benefit. In
this case it is better to first use the TM to extract the tiles, and to only perform the NRR on those
smaller regions. If the SNR size is poor, then it may be necessary to first register the images (see

below).

Image Registration followed by Template Matching (RR - TM—-> NRR)

When the image-series SNR is very poor, such as low-dose image data, then correctly identifying
the repeats of small motifs may become less precise. In this case, it is preferable to first align the
series data by rigid registration and collapse this to a single average frame with higher SNR before
performing the TM. This approach is also useful, when there are many repeats of the motif in each
frame, and where extracting all these from every frame would yield an excessively long synthetic

series.

Name convention for a series of images
The correct numbering structure is “Data_name_[xxx]”, where [xxx] is some increasing number
series. This structure is the same as the DM menu “File > Save as series...” command. The image-

series (as separate files) and the Sl-series should be stored in the same folder.
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Pre-treating the Data

In the same way as for aligning image series, it can be useful to first remove any image-ramp
intensity variation. This may help the TM module identify tiles more reliably. Similarly, if
processing STM/AFM data, first rigid-aligning and tip-height correcting the data will help in the

identification of more reliable motif matches.

Defining the Motif
There are two approaches for defining the motif; from the image itself or from an external source
(such as a simulation or some other high-quality image data). If using an external motif from a

simulation or from another image, you can skip to the next section.

To identify a motif within the image that is of interest, simply draw a ROl using the ROl tool from

the menu.

1]
Smartalign  Help
— + Wil -

There is no restriction on the size or shape that this ROI can take, other than it must be smaller
than the parent image. However, for images with a low SNR, selecting a very small ROl may lead

to less reliable tile repeats being identified.
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Note: the number of tiles that will be identified will depend on the size of this ROI. For example,
if the ROl is small and contains only (say) one unit-cell of a crystal structure, then the number
of tiles found will be approximately the same as the number of unit-cells in the image
(excluding part-cells at the image edges). However, if the ROl is very large, the number of cells

excluded at the edges increases and the number of tiles found will decrease.

We will now determine the motif from the image in a two-stage process; first we estimate the
motif from a single noisy ROI, then this is used to search the image again. This two-stage motif
calculation makes the template matching approach far more robust to experimental noise and

distortion. With the ROl drawn select “Define Motif...” from the TM command:

Define Motif...

Detect Motifs for 3
Mon-rigid Motif Alignment for 3
Align Second Signal by Matif for b
Align 51 Data by Motif for 4

Clean-up Motif Detection temporary data...

About TM Module...

The image will then be searched for potential repeats of the motif, and these will be labelled over

the image as blue dots*:

Tip: Adjusting the image contrast or gamma (see above) may make these markers easier to

see.
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At this stage you will also be presented with a histogram of the correlation-scores that indicate
the quality of the matches that have been found. A perfect score would be one, whereas zero

represents no-match at all.

% G: Histogram of Template Matching - O g
45 ;
a0 .
35-
30-
oy
c 254
3
g 20+
fre
15+
10+
>
0.8 Quality**—0.2 Quality—
T T T

00 01 02 03 04 05 06 07 08 09 10
Quality

The display settings for this histogram can also be adjusted, for example to enlarge one part or

adjust the number of bins, using the histogram dialogue.

HREM Histogram x
Select threshold and press OK

Min: |EI.IZI Maix: |1.EI

Mo of bins: | 200

Ok | | Cancel | | Home | | Apply

After changing any of the parameters, simply press “Apply” to update the histogram.

Next, the user must select the quality threshold of the tiles to keep. This is done by dragging the
left edge of the dashed box displayed on the histogram. As you adjust the threshold the colour of
the markers will change from blue to red if they are above the threshold. In this way you can

interactively determine the appropriate threshold.

The figure below shows an example where the histogram scale has been enlarged to show the
region 0.4-0.8, with a threshold set part-way thought the main peak in the match-quality
histogram (at 0.6):
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Frequency

40 0.45 0.50 . 0.60 X . ¥ 0.80
Quality

The result is that the highest quality matches (most similar to the motif) are coloured red and the

other (non-selected) candidates remain blue.

In the next example below, selecting a quality threshold of 0.54 includes all the reasonable

matches while rejecting poor ones around the image edges.

Frequency

l l 0.54 0.26 Quality

0.40 0.45 0.50 k 0.60 0.65 0.70 0.75 0.80
Quality

In general, the histogram will often show a peak around some value where the genuine matches

are grouped, and then some outliers to the left side that are poor quality matches.

Once you are happy with the set threshold press “OK” in the histogram dialogue and the identified
tiles will be extracted and averaged. This averaged tile then represents the same area as the

manually drawn ROl but at a far higher SNR (compare with the single manual ROl below-right).
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£ D: Cropped Si[110] Su... [ = |[-@
e = . =

L=
r

This image has the exact same pixel dimensions as the manually drawn ROl and is now available

to be used for the final template matching (next section).

Detecting Occurrences of the Motif

Single Opened Frame

The manually drawn ROl on the experimental data can now be deleted, and we use the result from
the previous stage to search the image. From the SmartAlign menu, select “Detect Motifs for” ->

“single opened frame...”:

Define Motif...

Detect Motifs for 3 single opened frame...
Mon-rigid Maotif Alignment for 4 all frames in the folder...
Align Second Signal by Motif for 4 selected frames in the folder...
Align 51 Data by Motif for 3

Clean-up Motif Detection temporary data...

About TM Maodule...

The user will be presented with the “Prepare data” dialog described in the earlier part of the
manual with some options pre-set ready for template matching. At this stage the user can select
up-sampling to achieve digital super-resolution, however as before it may take time to apply this

if the number of extracted tiles is very large.

This option will operate on an image (or image stack), which is open in the DM window. The other
options in this menu can be used to search through the images in a folder of a subset of those;
note that the time take to batch process multiple images in this way scales with the number of

images.
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Note: It is strongly recommended to test the TM on a single opened frame first before

”

processing an entire folder. However, in the case of “Detect Motif for...” it is a must to

perform “single opened frame” before processing multiple frames.

Next the user is asked to select the motif and the target images:

Template: |G: Refined Template e
Target: |B: Si[110] Substrate_JECL ADF1 =

K Cancel

Having created a “refined template” in the previous section, this should be selected as the
template and the experimental image selected as the target. Alternatively, if the template comes
from some external source (such as another experimental image patch or an image-simulation)

then this can be selected instead.

Note: when using an external reference template, the pixel-size (magnification), contrast
type (bright-field versus dark-field etc.) and the scan-rotation must be the same as the target

image.

Again, the histogram of match quality will be displayed:

% F: Histogram of Template Matching = O E
55
50+ (]
45- :
40+
354
g
c 30+
v
3
g 25
[
20-
15-
10-
S_
0,72 Quality **———0.28 Quality—
0+ T T T T T T T y t
0.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0

Quality

As the refined template was used as the search motif, we now see that the peak has shifted (in
this example case) from around 0.59 to 0.77. This is due to the two-stage motif definition process

followed where the refined template had an improved SNR over the initial estimate.
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Once the threshold has been selected, the individual tiles will then be extracted and stacked to

yield an image-series in the workspace.

Multiple Frames in the Folder

After detecting motifs from a single opened frame, the user can go on detect motifs from multiple
frames saved in the same folder. To do this, select “Detect motifs for...” -> “all frames in the
folder”, or “Detect motifs for...” -> “selected frames in the folder”. A file-open dialogue will open
and you should select the first file from those with the sequential naming scheme. When you
select “Open”, this will search for, and store all the locations of, all matches across the series of
image-files. You will be asked whether to use a ‘fixed threshold’, this option will use the same
match quality score between all frames and is usually the most appropriate choice (all frames will
be processed unsupervised). Should the data suffer from irregular contrast changes or excessive
beam damage, you may want to disable this option and choose the threshold manually for each

frame (operator selection required for every frame).

Note: temporary data to support the calculation is stored in a sub-folder named “SA_temp”,
These temporary files store the locations of all the identified tiles and should not be

deleted/modified until the whole template matching is complete.

During the motif search you will be able to watch the progress in the Output panel. After all frames
in the series have been searched a message will tell you the total number of motif matches that

were found across the entire series.

DigitalMicrograph X

o Detect Motifs is Finished. Total number of detected motifs is 4325.

In this example, across the 16-frames of the experimental series, a total of =4,300 tiles were

identified.
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Non-rigid Registration of the Extracted Tiles

Once the tiles have been extracted they can be considered as a series of experimental
observations. Where scanning-distortion is present, the non-rigid registration (NRR) may be
needed. You can perform non-rigid registration from “Non-rigid Motif Alignment for...” command

below:

Define Motif...

Detect Motifs for 4

Non-rigid Motif Alignment for 4 single opened frame..,
Align Second Signal by Motif for 4 multi frames in the folder...
Align SI Data by Motif for >

Clean-up Motif Detection temporary data...

About TM Module...

Note: as the tiles were extracted using template matching it is not necessary to perform the

rigid registration step normally needed in SmartAlign for experimental data series.

It is strongly recommended to test the NRR on a single opened frame first before processing an
entire folder. To do this, select “Non-rigid Motif Alignment for...” -> “single opened frame” when
the front image is the target. Then, you will get the dialog for the “Non-Rigid Registration”

described in the earlier part of the manual with some options adjusted for the template matching.

When the user has finished non-rigid alignment for a single opened frame, this can be performed
for multiple frames saved in the same folder. To do this, select “Non-rigid Motif Alignment for...”
-> “multiple frames in the folder”. A file-open dialogue will open, and you should select the same
image as before (the first in the series of frames). Note that the same parameters which were

selected for “single opened frame” will be used for the command “multi-frames in the folder”.

Note: temporary data to support the calculation is stored in a sub-folder named “SA_temp”.
These temporary files store the transformation data and should not be deleted/modified

until the whole template matching is complete.
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Template Matching a Second Signal / Spectrum Image
Once the repeats of a motif have been identified it is possible to extract the equivalent patches
form another image signal or form a spectral image (Sl). To perform this, select “Align Second

Signal by Motif for ...” or “Align SI by Motif for ...” from the TM commands below:

For a second signal:

Define Motif...

Detect Motifs for »

Non-rigid Motif Alignment for »

Align Second Signal by Motif for > single opened frame...
Align SI Data by Motif for 4 multi frames in the folder...

Clean-up Motif Detection temporary data...

About TM Module...

For Sl data:

Define Motif...

Detect Motifs for 4

Non-rigid Motif Alignment for 4

Align Second Signal by Motif for 4

Align S| Data by Motif for 4 single opened frame...
Clean-up Motif Detection temporary data... multi frames in the folder...
About TM Module...

The required data is different for these two cases as follows:

TM Across a Second Signal(s)

For this process, the user should have (for example) an image/stack from a dark-field image and a
simultaneous data from a bright-field signal. The user should choose whichever signal that has the
higher SNR as the “master” signal and should work on this first. Once the TM is complete on the

master signal, simply select “Align Second Signal by Motif for...” from the TM command.

As usual, it is strongly recommended to test the command on a single opened frame first before
processing an entire folder. To do this, select “Align Second Signal by Motif for ...” -> “single

opened frame” when the front image is the target.
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TM Across an SI or SlI-series
For spectrum image TM, the user must have a single image-SI pair, or a series of image-SI pairs.
These must have been recorded simultaneously and with identical x-y pixel dimensions. The

images should exist on the disk as separate files, numbered sequentially as for the SI*.

Note: the correct numbering structure is “Data_name_[xxx]”, where [xxx] is some increasing
number series. This structure is the same as the DM menu “File > Save as series...” command.

The image-series (as separate files) and the Sl-series should be stored in the same folder.

In the case of TM across a series of spectrum-images, one image may have 100s of repeated

motifs, tens of frames, and thousands of Sl channels. Because of the scale of this calculation, it is
important to test the behaviour on a single opened frame first before processing an entire folder.
To do this, select “Align SI by Motif for ..."” -> “single opened frame” when the front image is the

target.

When you test the behaviour on a single opened frame, you can perform non-rigid alignment for
a multiple Sl data saved in the same folder. To do this, select “Align S| Data by Motif for...” -> “multi
frames in the folder”. A dialogue will open for you to select the appropriate files; you again select
the firstimage in the series, and the first spectrum-image in the series. Both should have the same

sequential naming convention (such as below).

Reference signal: | HAADF_001.dm3 Select Data. ..
Target signal (SI): | EELS_SI_001.dm4 Select SI...
oK Cancel

The plug-in will now use the stored motif locations and the stored alignment data to search each
SI, extract the spectrum ROI, align it, and add it to a running summation with increasing SNR. This
calculation may take some time for data with many frames and many tiles-per-frame. A progress
bar will be shown to indicate the frame being processed and the tile within that frame being

extracted and realigned.
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SmartAlign X
Align SI Data

Frame: 1/5

Tile: 1/25

Cancel

After the TM is complete across the series, the results will be displayed, and the user may choose

to “Clean-up Motif Detection temporary data” from the menu and the temporary files will be

deleted.
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Troubleshooting

Auto-save function not working with some detector channels.

On some systems you may see the following error when trying to use the auto-saving feature for
some detector choice settings:

The system cannot find the path
specified.

This is caused when the detector name itself contains a slash ( “/” ) character causing the
filename to try to access a non-existent directory.

To correct this, go to the DigiScan Setup menu, select “Advanced” > “Analogue Input” and edit
the name of the detector causing the error; in this case “Gatan BF/DF” can be changed, for

example, to “Gatan BF-DF”.

Flip Horizontal Scan
uie Fiyback Time (is)  1000.0

%2 Rotation Offset (deg) 180
Pixel Time (us) 8.0 20.0 8.8 [ Maximize Scan Area
Min Frame Time () 0.78029 5.7549 41.709
[T]Line Sync [T]Line Sync [¥]Line Sync
bz ol [Cintegrati [Csum Frames
80 % 80 % 4

(byte  v| @ [sbyte v Wl{abyte  ~]
[sbyte  ~| [ [sbyte
[sbyte  ~| @ [sbyte DigiScan Analog Input Setup

Invert Signal Signal Name Gain  Offset
[JAndogd  JEOLADF (3500 | [1800 |
Clansopt  JEoLADRz [0 ][0 |
Clansos? g [0 ] 100 |

onss v )

ook J[concal J[ tesy |
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